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1. BACKGROUND

This guide is intended to help sponsors create Simplified TS Files (ts.xpt) to meet study data submission
requirements to the Food & Drug Administration (FDA) Center for Drug Evaluation and Research (CDER)
and the Center for Biologics Evaluation and Research (CBER).

Simplified TS Files provide a Study Start Date for NDA/BLA/ANDA studies that began on or before
December 17, 2016 and Commercial IND studies that began on or before December 17, 2017 and allow
FDA to determine that study data is not required to be in a CDISC standardized format. For additional
information on FDA'’s study data submission requirements, please see the Technical Rejection Criteria for
Study Data and the Study Data Technical Conformance Guide.

Simplified TS Files are SAS Transport files which can be created using free and open-source software,
including Python and R.

Option 1 provides information to install R and R code to create a Simplified TS File using two different R
packages. Steps to install both packages are provided. You will have to make simple edits to the code to
provide details of the study.

Option 2 provides information to install Python and Python code to create a Simplified TS File. You will
have to make simple edits to the code to provide details of the study, such as Study ID and Study Start
Date. To create SAS Transport files in Python, the Xport module must first be installed. Steps to install
the module are also provided.

The final section provides details on how to install and use SAS Universal Viewer to review the Simplified
TS Files you create.

2. CREATE SIMPLIFIED TS.XPT FILES
a) Option 1: Use R
i) Pre-Requisite: Install R

To install R, please refer to www.r-project.org and follow the installation instructions.

o & | https://www.r-project.org/ T

The R Project for
Statistical Computing

[Home] Locate the
Download rted
Download Option

RIsieeeeeeewvare environment for statistical computing and
graphics. It compiles and runs on a wide variety of UNIX
platforms, Windows and MacOS. To download R, please chc

CRAN

R Project
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Once you have installed R, open the R application and Install R packages.

1. Select the “Packages” menu R RGui (54-bit)
2 Se|eCt “|nSta|| PaCka e(S)" File Edit Vie sc  Packages Windows Help
: 9 E E Load package...

Set CRAN mirror...
‘R R Consol - ==
EEE Select repositories...
Install kage(s)...
R version 3uE0 package "
Copyright (C) 201 Update packages... Computing

Platform: x86_€4-

Install package(s) from local files...

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to rediscribute it under certain conditions.

3. Select a CRAN Mirror.

Secure CRAN mirrors
Note: You may select any \

CRAN mirror, but it is 3552‘7253[2&&]-“]' '
recommended that you select - USA (KS) [htt;:s]

one close to your geographical USA (MI 1) [https]
mi Y geograp é.: USA (OR) [https]
proximity. el e

oK Cancel

4. Install “Hmisc” and either Packages
“haven” or “SASxport.” — L

P 1Hmisc | -~

e
{hmm.discnp
[\ ACant.

Packages

B o B e
;homals
{homeR
{Homeric v

OK Cancel OK Cancel

[

Packages
‘ ;SASxpon N
| |sateliite

| satscanMapper

{saturnin

lea . A |

oK Cancel
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ii) Create Simplified TS.xpt Using R

Step 1 — Open the R application and create a New script file
‘R RGui (64-bit)
File Edit View Misc Packages Windows Help

Source R code... I

New script
Ofen serit " File->NewScript
Display file(s)...
) == "Planting of a Tree"
Load Workspace... undation for Statistical Comput
Save Workspace... Ctrl+S 2/x64 (64-bit)
Load History... s with ABSOLUTELY NO WARRANTY.
Save History... ibute it under certain conditior
e () ' for distribution details.
Change dir...
but running in an English local
Print... Ctrl+P
Save to File...

ct with many contributors.

Step 2 — In the R Editor window, copy and paste the applicable code from Table 1, depending on the type
of study and which R package you are using:

Table 1: Code for Creating TS.xpt Using R

R Package Clinical Study Non-clinical Study
#H#tLoad Packages## ##Load Packages##
Using the Library (haven) Library (haven)
Haven Library (Hmisc) Library (Hmisc)
Package -
Option A ##Create data file## ##Create data file##
data<-data.frame(STUDYID="XYZ123’, data<-data.frame(STUDYID="XYZ123",
TSPSRMCD="SSTDTC”, TSPARMCD="STSTDTC",
TSVAL=strftime(as.Date(“YYYY-MM- TSVAL=strftime(as.Date(“YYYY-MM-DD"),"%Y-
DD"),"%Y-%m-%d"), %m-%d"),
TSVALNF="", TSVALNF="",
stringAsFactors=FALSE) stringAsFactors=FALSE)
##Add data label and variable labels## ##Add data label and variable labels##
label (data) <-'Trial Summary’ label (data) <-'Trial Summary’
label (data[['STUDYID’]]) <-'Study Identifier’ label (data[['STUDYID’]]) <-‘Study Identifier
label (data[[ TSPARMCD']]) <-'Trial Summary Parameter label (data[[ TSPARMCD']]) <-'Trial Summary Parameter Short
Short Name’ Name’
label(data[[ TSVAL']) <-'Parameter Value’ label(data[[ TSVALT]) <-‘Parameter Value’
label (data[['TSVALNF']]) <-‘Parameter Null Flavor’ label (data[[ TSVALNF']]) <-‘Parameter Null Flavor
##Write data into xpt format## ##Write data into xpt format##
write_xpt (data, path="C:/Simplified TS File/ts.xpt”, version=5) | write_xpt (data, path="C:/Simplified TS File/ts.xpt", version=5)
##tLoad Package## ##Load Package##
Using the Library (SASxport) Library (SASxport)
SASxport Library (Hmisc) Library (Hmisc)
Package -
Option B #Create data file## ##Create data filettt

abc<-data.frame(STUDYID="XYZ123",
TSPSRMCD="SSTDTC",
TSVAL=strftime(as.Date(“YYYY-MM-
DD"),"%Y-%m-%d"),
TSVALNF="",

abc<-data.frame(STUDYID="XYZ123’,
TSPSRMCD="STSTDTC",
TSVAL=stritime(as.Date(“YYYY-MM-
DD"),"%Y-%m-%d"),
TSVALNF="",
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stringAsFactors=FALSE)

##Add data label and variable labels##

label (abc) <-‘Trial Summary’

label (abc$STUDYID) <-'Study Identifier

label (abc$ TSPARMCD)<-Trial Summary Parameter Short
Name’

label (abc$TSVAL) <-‘Parameter Value’

label (abc$TSVALNF) <-‘Parameter Null Flavor

##Write data into xpt format##

stringAsFactors=FALSE)

##Add data label and variable labels##

label (abc) <-Trial Summary’

label (abc$STUDYID) <-‘Study Identifier’

label (abc$ TSPARMCD) <-‘Trial Summary Parameter Short
Name’

label (abc$TSVAL) <-‘Parameter Value'

label (abc$TSVALNF) <-‘Parameter Null Flavor

##Write data into xpt format##

write_xport (abc, file="C:/Simplified TS File/ts.xpt”) write_xport (abc, file="C:/Simplified TS File/ts.xpt”)

Step 3 — After copying and pasting the code into the script editor, modify the code with your study
parameters as follows:

1. 1\|ext to S;I’UPYID, replfl;lce s R Unced  REBoor
XYZ123” with the applicable e NS ARG
Study 1D [ Library (haven)
2. Nextto TSVAL, replace S Hibrary (Tnigy
“YYYY-MM-DD” with the el HCroate dat N ——
) data<-data.frame STUDYID="XYZ123”
applicable study start date ‘MR ' TSPSRMCD="SSTDTC™; i

lmGimme (as.
TSVALNF=" “,
eurrnymsraveo ' S=FALSE)

2 “YYYY-MM-DD” J§, ”$Y-%m-%d”) ,

3. If no Study Start Date is
available, delete “YYYY-MM- wief T
DD”, keeping the quotation trisH
marks, and next to
“TSVALNF”, enter a valid
Study Start Date Exception
Code

##Add data label and variable labels##
label (data) <-'Trial Summary’
' label (data[['STUDYID’]]) <-'Study Identifier’
label (data[[‘TSPARMCD’]]) <-'Trial Summary Parameter Short Name’
label (data[[‘'TSVAL’]]) <-‘Parameter Value’
label (data[[‘TSVALNF’]]) <-‘Parameter Null Flavor’

4. The file path, i.e. where the
Simplified TS File will be
saved, can be changed to your
preferred location by replacing
“C:/Simplified TS File/” with a
different location

##Add data label and variable labels##
label (data) <-'Trial Summary’
' label (data[['STUDYID’]]) <-'Study Identifier’
label (data[[‘TSPARMCD’]]) <-'Trial Summary Parameter Short Name’
label (data[[‘'TSVAL’]]) <-‘'Parameter Value’
label (data[[‘TSVALNF’]]) <-‘Parameter Null Flavor’

##Write data into xpt  formatis
write_xpt (data, path="C:/Simplified TS File/ts.xpt”| version=5)

¢ Note: While editing Study ID, TSVAL, and TSVALNF, keep the quotation marks around the values you
enter

Version 2.0, FDA Internal Use Only 6
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Step 4 — After updating the code, run the code by selecting run all from the Edit Menu. A Simplified TS
File in .xpt format will be saved in the folder C:/Simplified TS File or the location you provided.

R RGui (64-bit)

File Edit Packages Windows Help

Undo Ctri+Z
LOpYy
Paste Ctrl+V
Delete
Select all Ctri+A
Clear console Ctri+L
Run line or selection Ctri+R
Runall

Version 2.0, FDA Internal Use Only 7
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b) Option 2: Use Python
i) Pre-Requisite: Install Python and IDLE

To install Python and IDLE, please refer to www.python.org/downloads and follow installation instructions

}

F)
‘ &« G @ Python Software Foundation [US] | https://www.python.org

Python

e python”

About Downloads Documentation

D110 Bi A Locate Download

Download Python 3.7.3

Looking for Python with a different 0S? Python for Windows,

IDLE is Python’s Integrated Development and Learning Environment, also referred to as the Python Shell

To install the Xport module in Python please refer to https://pypi.org/project/xport/

1. Atthe CMD.exe command line Administrator: Command Prompt
interface, type in the following
command and press ENTER:

cd C:\Program
Files\Python37\Scripts hed ii%

2. Type in: python -m pip install -- alling ge
upgrade pip (to ensure pip is at the g
latest version)

3. Type in: pip install xport (to install
the xport module)

/a@/ade37253fe

ii) Create Simplified TS.xpt Using Python

Create a Simplified TS File in Python with the following steps:

Version 2.0, FDA Internal Use Only 8
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Step 1 — Create a Folder in C Drive and name it as “Simplified TS File”

= 5] Manage Local Disk (C:)
Home Share View Drrive Tools
&« v P i » ThisPC » Local Disk (C:)
~
[ Name Date modified Type Size
s+ Quick access
Jdlerc /2019 10:44 AM  File folder
e Creative Cloud Files Intel 018206 PM  File folder
@ OneDrive Perflogs File folder
Program Files File folder
3 This PC Program Files (x86) File folder
= Network Users File folder
[ Windows File folder
|J msdial0.dll Application extens... 234 KB
Simplified T5 File File folder
Step 2 — Open the IDLE application
All Apps Documents Settings Web More - Feedback

Best match
. IDLE (Python 3.7 32-bit) > a
Desktop app
A
ppe IDLE (Python 3.7 32-bit)
IDLE (Python 3.7 64-bit) > Desktop app

Search the web

/O idl - See web results

\/
a

Open
Run as administrator

Open file location

T 8 4

Pin to Start

Step 3 — Create New File
e File > New File
| & Python 3.7.3 Shell
File Edit Shell Debug Options Window Help

Mew File Ctrl+M ceedl2, Mar 25 201%, 21:

COpen... Ctrl+0 ) )
Open Module Alt+M "credits™ or "license ()
Recent Files *

Module Browser Alt+C

Path Browser

Version 2.0, FDA Internal Use Only 9
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Step 4 — Paste the Python code and save the file with any file name, e.g. “Python Code for Simplified TS”
e Paste the Python Code exactly as shown in Table 2.

Table 2: Code for Creating TS.xpt Using Python

Step Clinical Study Non-clinical Study
Step 1 - #timport the xport module### #timport the xport module##
Import the xport import xport import xport
module
Step 2 - #tGenerate the simplified ts file## ##tGenerate the simplified ts file##
Generate the mapping={"STUDYID"['XYZ123", mapping={"STUDYID"[XYZ123",
simplified ts file "TSPARMCD"['SSTDTCY, "TSPARMCD":['STSTDTC,
"TSVAL'['YYYY-MM-DDY, "TSVAL"['YYYY-MM-DDY,
"TSVALNF"[']} "TSVALNF"[']}
with open ('C:/Simplified TS File/ts.xpt','wb') as f: with open ('C:/Simplified TS File/ts.xpt','wb') as f:
xport.from_columns(mapping, f) xport.from_columns(mapping, f)

e Note: The Python Xport Module does not allow you to add data and variable labels to .xpt files.

Step 5 — After copying and pasting the code into the script editor, modify the code with your study
parameters as follows:

1. Nextto STUDYID, replace | & Python Code for Simplified TS.py - C:/Simplified TS File/Python Code for Sin
‘XYZ123’ with the

applicable Study ID ‘ —
2. Nextto TSVAL, replace ##Import the xport module##

‘YYYY-MM-DD’ with the

applicable study start date

File Edit Format Run Options Window Help

import xportl

'TSPARY s [*SSTDIC'],

o' YYYY-MM-DD' ]|,

ALNF": 1771}
with open ('C:/Simplified TS File/ts.xpt','wb') as f:
xport.from columns (mapping, f)
3. If no Study Start Date is mapping={'STUDYID":['XYZ123'],
available, delete “YYYY- ISR =1 SSIDICH ],
MM-DD’, keeping the b, > | ;ff]*;m*‘“ 1.
apOStrOpheS , and next to with open"t Cr7oimplified TS File/ts.xpt','wb') as f:

‘TSVALNF’, enter a valid
Study Start Date
Exception Code

xport.from columns (mapping, f)

Step 6 — Run the Python Script. A Python shell window will pop up and the TS.xpt file will be generated

Version 2.0, FDA Internal Use Only 10
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L& Python Code for Simplified TS.py - C/Simplified TS File/Python Code for Simpli
File Edit Format Run Options Window Help
##Import the = Python Shell

Check Module Alt+X
Run Module F5

import xpclIt.I

##Generate the simplified ts file#sd

mapping={'STUDYID':['XYZ123'],

"TSPREMCD® : ['S5TDTC'"],

"TSVRL: ["YYYY-MM-DD"],

"TSVALNFE':["']}

with open ("C:/Simplified TS5 File/fts.xpt','wbh') as £:
zport.from colunns (mapping, I)

Step 7 — View the TS.xpt file in the folder created in Step 1, above.

S » This PC » Local Disk (C:) » Simplified TS File

] Mame Size
E Python Code for Simplified T5. 1EKB
yt P PY
a texpt 2 KB

Version 2.0, FDA Internal Use Only 11
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3. VERIFY CREATED TS.XPT FILE

The reader can use any market available tools to review and verify the ts.xpt file. One example of such
tools that’s available to use is the SAS Universal Viewer. The instructions for installing and using SAS
Universal Viewer are provided below.

a) Pre-Requisite: Install SAS Universal Viewer
The SAS Universal Viewer is installed on the reader’s computer to open and view Simplified TS Files:

To install the SAS Universal Viewer, please refer to
https://support.sas.com/downloads/package.htm?pid=2173 and follow the installation instructions.

Readers with an existing SAS user accounts can log in and download package through the link; new
users will create an account first, then access to the link.

G SAS Downloads: SAS Universal V' X + = x

< (&) @ htipsy//support.sas.com/dewnloads/package.htm?pid=2173 * 8

Gsas

Home Support Learn Connect

SUPPORT/ DOWNLOADS & HOT FIXES

SUPPORT All Downloads

 Manage Tracks Downloads
o SAS Administrators
o Security Bulletins SAS Universal Viewer
o License Assistance Release 1.43 - FEB 2018
© Manage My Softwars Account

The SAS Universal Viewer is a replacement for the SAS System Viewer and is an application for the Windows environment to view SAS data sets and other simple text-based files. You
cannot edit SAS data sets with the SAS Universal Viewer, but you can sort and filter data sets. The SAS Universal Viewer enables you to view the contents of SAS data sets without
invoking SAS and without installing SAS on your machine

JMP Software
P To begin the download process, select the item in the table below which best meets your needs
Mobile Device Software !

Third Part

Additional Froducts SAS Universal Viewer
Hot Fixes
I T N S T e et
& Knowledge Base
Microsoft® Windows® for x64  SAS Universal Viewer  sasuniviewer__94160__wxG_en__web__1zip  473ME 513MB 2018-02 paf | txt
Wwindows SAS Universal Viewer  sasuniviewer__94160__win__en__wen__1zip  475MB 515MB 2018-02 pof | txt
Note: The Software is provided as a convenience. Limited or no technical support is provided for

the Software

For questions you may have about this download, please contact our Product Support Group

b) Open and Review Generated TS.xpt File

After creating the simplified ts.xpt file, please open the file in SAS Universal Viewer to make sure it is
formatted correctly and includes the correct Study ID and Study Start Date.

Open the Simplified TS File in SAS Universal Viewer with the following steps:

e Open SAS Universal Viewer

e From the File menu select Open

o Enter the file path of the Simplified TS File in the Address field to open the file (C:/Simplified TS
File in the sample code)

Version 2.0, FDA Internal Use Only 12
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Figure 3: Example View of a Clinical Study

SAS Universal Viewer

File Tools Window Help

Address |

Ets.xpt
Library Properties dataset
U] Freeze [Il] Hide [[J] Show... £% Format [} Filter... A Font.. Find

Table

View

» 1

STUDYID

TSPARMCD

TSVAL TSVALNF

SSTDTC

YYYY-MM-DD

(e)f@]=]

Properties for Simplified TS files can be viewed under the Properties tab in SAS Universal Viewer.
Because the Python Xport Module does not have advanced properties capabilities, metadata such as
variable labels cannot be assigned. The R packages include more advanced capabilities to edit XPT file
properties. Figures 4 and 5 illustrate the differences between Simplified TS Files created in Python and R.
In Python, the Variable Labels are assigned by default and are the same as the Variable Names. In R, the
Variable Labels can be assigned and are labelled with the full description of the variables, as they would
be labelled in a Full TS File that conforms to CDISC standards. The sample code for R includes the
appropriate Variable Labels.

Figure 4: Example View of File Properties of Simplified TS File Created with Python

Name Obs Vars| # Vaiable  Type Length Fomat Infomat Label
dataset 1 4 i STUDYID | Character STUDYID
1/ TSPARMCD |Character TSPARMCD
2|TSVAL  |Character 10 TSVAL
3|TSVALNF | Character 0 TSVALNF
S S S|

Figure 5: Example View of File Properties of Simplified TS File Created with R

Name Obs Vars| # Variable Type Length Format  Infomat Label
dataect . ol flsoro [oeece | ls s | Study Identfier
1/TSPARMCD | Character 6ls .|s | Tral Summary Parameter §
2|TsvAL | Character 0ls  ..|s Parameter Valve
3|TSVAINF~ |Chacter |  0/S .. |S .. |Parameter Nul Ravor
EEE e e e |

4. APPENDIX: ADDITIONAL RESOURCES

Document

Technical Rejection Criteria for Study Data https://www.fda.gov/media/100743/download
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Python Download & Installation Instructions

R Download & Installation Instructions

Xport Module Information

SAS Universal Viewer Download & Installation Instructions

www.python.org/downloads

www.r-project.org

https://pypi.org/project/xport/

https://support.sas.com/downloads/package.htm?pid=2173
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